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1. Pagination 

Sections that contain many products may now be split into multiple pages, with navigation links 

generated automatically. Pagination is enabled by default for sections with more than 10 products.  

 

The defaults are set in Settings | Site Options | Page Settings | Section, but can be overridden Section 

by Section using the equivalent settings in the Page Settings tab of the Section Details. 

 

‘Is Full Page Included In Pagination’ – leave as ‘True’ to retain a ‘View All’ option for shoppers 

to view all the products in one page. 

‘Section Pagination Products Per Page’ – sets the number of products per page. Default is 10. 

To disable pagination, change to zero. 

‘Visible Section Navigation Links’ – the maximum numbered page links to be shown between 

the forward and back links. Default is 5: 
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2. Filtering 

Filtering is a popular browsing method that is widely adopted on larger ecommerce sites. It allows 

customers to successively refine their view of a set of products by making a series of selections. For 

example, when viewing a page of t-shirts, a shopper may choose to view only those which are 

available in size Medium and colour Red. 

SellerDeck 2013 makes the same functionality available for the first time in a desktop ecommerce 

package.  

 

By default, each selection in the filter shows the number of results it will return, and options with 

zero results are shown but greyed out. Counts can be disabled and no-result options suppressed via 

new settings in the ‘Options’ tab of the ‘Search And Filtering Settings’ dialog (formerly ‘Search 

Settings’). 

 

Filtering can also be used to populate pages dynamically with products from elsewhere in the site, 

enabling you to create multiple site hierarchies without using product duplicates (see below). 

a. General Filtering 

You can create any number of filters which can be used in any section of the site. 

First we need to add an attribute to filter on: 

1. Click the [+] icon next to the ‘Earrings’ section in the Content Tree, and then the same icon 

next to the ‘Birth Stone Earrings’ subsection. 

2. Right-click on the ‘January – Garnet’ earring and select ‘New Attribute’. 

3. Enter ‘Metal’ for the attribute name. 
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4. Right-click on the ‘Metal’ attribute and select ‘New Choice’. Enter ‘Yellow Gold’ for the 

choice name, and add a further choice of ‘White Gold’. 

5. Hold down the Ctrl key and drag the Metal attribute to the next earring. Add an additional 

choice eg ‘Platinum’ or  ‘Silver’. 

6. Repeat for the other earrings, varying the list of choices in each case. 

 

Next, we need to create a filter that uses the attribute, and apply it to this section: 

7. Click on the ‘Birth Stone Earrings’ section. Click the ‘Section Details’ tab at the bottom of the 

screen, and then on ‘Filtering’. 

8. Click the ‘Add / Edit Filters’ button. In the ‘General Filtering’ tab of the dialog that opens, 

click ‘New Filter’. 

9. Give the filter the name ‘Earrings’. 

10. Click the [+] icon against ‘Property’ and select ‘Metal’ from the drop-down. (You can add as 

many properties as you like to a filter. You can also add price bands if you want shoppers to 

be able to select products in a particular price range). 

 

11. Click ‘OK’.  

12. Back in the ‘Filtering’ tab of the Section Details, tick ‘Enable Filtering and Sorting’ and untick 

‘Make Filtering the Default View’. 

13. Under ‘Details of Filter’, select the General Filter ‘Earrings’. 
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14. Click ‘Apply’. 

 
 

Preview the page and you will see the filter choices in the left-hand sidebar. 

NB filtering uses scripts and consequently does not function in local preview. You will need to 

upload the site to try your filters out. You can do this in Test Mode to avoid overwriting your 

live site. 

b. Category Filtering 

In the real world, different types of product can have different and unique characteristics that do 

not apply to other types of product. For example, when browsing digital cameras you may want 

to select by the number of megapixels, but this selection would not be relevant for T-shirts. 

Category Filtering recognizes these distinctions, enabling you to create different Categories for 

different types of product, each with its own unique set of filters.  

 

To see how this works, try the example below. 

First, we need to create a Category and its corresponding variable(s), and allocate products to 

the Category. 

1. Select ‘Content Categories’ from the ‘Design’ menu and then select ‘Product’. 

You only need to use Category Filtering if your catalogue has this type of product-specific 

data, and you want to enable shoppers to make selections based upon it. 
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2. Click the ‘New’ button and enter ‘Necklaces’, then click ‘OK’. 

 

3. Select ‘Library’ from the ‘Design’ menu and click the ‘Variables’ tab. 

4. Right-click ‘Product’ and select ‘New’. 

5. Enter ‘Length’ for the Name and Prompt. And tick ‘Product’ under ‘Place of Setting’ 

6. Tick ‘Searchable’ and change the Type from ‘Text’ to ‘List of Choices. 

7. Select the ‘Values’ tab, click ‘New’ and type  ‘13”’. Repeat and add values of  18” and 20”. 

 

8. Select the ‘Place of Setting’ tab. 

9. Expand ‘Product’ by clicking its [+] icon and untick ‘Standard’, then click ‘OK’.  

10. Lastly, click on each product in the Necklaces section. Change the Category of each to 

‘Necklaces’ (in the ‘General’ tab of the Product Details) and select a Length for each one (In 

the ‘Properties’ tab of the Product Details). 

Now we can define the filters to be made available when shoppers browse the necklaces page.  

1. Click on the ‘Necklaces’ section. Click the ‘Section Details’ tab at the bottom of the screen, 

and then on ‘Filtering’. 

2. Click the ‘Add / Edit Filters’ button. In the dialog that opens, select the ‘Category Filtering’ 

tab. 
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3. With Product Category ‘Necklaces’ selected, click the [+] icon in the corner of the ‘Property’ 

table and select ‘Length’ from the drop-down menu. 

 

4. Click ‘OK’ to save the filter and return to the Section ‘Filtering’ tab. Change ‘Where Products 

Are in Category’ to ‘Necklaces’. 

 

 

c. Using Filters To Fill Sections Dynamically 

You can use filtering to create sections that are populated automatically with products that fit a 

specific filter. See the following examples:  

1. Create a section for a specific brand.  

a. Give each of your Necklaces a brand (Product Details | General | Google Data Feed 

Brand). Make two of them ‘SellerDeck’ and the others something different. 

b. Set the Brand to ‘SellerDeck’ for some other products in different sections. 

c. Create a new General filter called ‘Brand’, and add the property ‘Brand’ to it. Add 

some price bands as well. 

d. Create a new section and call it SellerDeck, but don’t add any products to it. 

e. In the section Filtering tab, tick ‘Enable Filtering and Sorting’ and ‘Make Filtering the 

Default View’. (The latter selection tells SellerDeck to populate this section 

dynamically with products that fit the criteria specified below). 

f. Leave Section set to ‘All Sections’ and Category set to ‘Any Category’ 

g. Click the ‘+’ icon against ‘Property, select ‘brand’ from the drop-down menu and 

enter a value of SellerDeck. 
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h. Under ‘Details of Filter’ select ‘General Filter’ and ‘Brand’. (This defines which set of 

filtering options will be offered in the left-hand sidebar of the web page. The other 

settings define which products will appear on the page initially). 

 

i. Upload and go to the Nikon page and you will see something like the following: 

 

You can use any valid product property or attribute to define the content of a section. 

You can also limit the selection to products in a specific Category by choosing it in the 

Category drop-down. In this case, the filter for that Category will automatically be 

applied in the left-hand sidebar. 

It’s easy to combine these two approaches to create, for example, a ‘Nikon’ section 

with subsections for different Categories of product.  



© 2012 SellerDeck Ltd 

3. Dynamic Choices 

In earlier versions of SellerDeck (and Actinic Desktop) applications, product choices were not 

interdependent; it was not possible to vary the choices offered for one property (eg size) depending 

on the selection made by the shopper for another (eg colour).  

The new Dynamic Choices feature introduces this level of dependency, allowing invalid combinations 

to be suppressed dynamically on the web site. If a shopper selects, for example, size Medium, the 

colour drop down will change to offer only colours that are available in that size. 

The Dynamic Choices feature is enabled by default for all products. The function comes into effect 

wherever a product has a Component with multiple Attributes. The Component is required, but can be 

hidden by blanking the ‘HTML for Name’ field in the General tab of the Component Details. 

To define which combinations of choices are valid and invalid, go to the ‘Permutations’ tab of the 

Component and click the ‘Fill List’ button. Then untick the ‘Valid’ checkbox for any permutations that 

you want to prevent being ordered: 

 

NB ‘Fill List’ is greyed out if all possible combinations are already listed in the table 

Dynamic  Choices can be disabled for any product in its Properties tab, by setting Suppress Invalid 

Product Choices Dynamically’ to ‘False’; or disabled for the whole site in Settings | Site Options | 

Properties | Product. 
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4. Dynamic Pricing 

Dynamic Pricing enables the price shown on the web page to change dynamically if a shopper makes a 

selection that affects it;  for example, by selecting a component that adds to the price. Dynamic 

Pricing is enabled by default for all products that have Components which affect the overall price of 

the product. 

 

The dynamic price also changes to reflect the order quantity: 

 

Dynamic  Pricing can be disabled for any product in its Properties tab, by setting ‘Recalculate Prices 

Dynamically’ to ‘False’; or disabled for the whole site in Settings | Site Options | Properties | Product. 

 

The text shown in front of the dynamic price (default ‘Total Price’) can also be changed, by entering a 

different value for ‘Dynamic Price Prefix’.  

For products that use Dynamic Pricing, the standard Product Price Description of ‘Price’ can be 

changed to something more appropriate like ‘Base Price’ in the General tab of the Product Details: 
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5. Search Improvements 

a. Results Sorting 

By default, shoppers can re-sort search results by Relevance, Price Ascending, Price Descending, 

Name Ascending or Name Descending. There are several related settings in the Results tab of the 

Search Settings: 

 

• The radio button ‘Default’ sets the order in which the search results first appear to the 

shopper. The factory default is Relevance 

• The Label is the description used for that search order on the web site 

• The order in the table controls the order in which the sort options are presented to the 

shopper. It can be changed using the arrow keys to the right 

• You can disable sorting by any particular order by unticking its ‘Enabled’ checkbox 

Sorting by relevance uses a weighting system to put the most relevant results first. For 

example, if a search term appears in a product name, the product will be listed higher than if it 

only appeared in the description.  
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b. Refined indexing 

SellerDeck 2013 provides more control over which fields are indexed for text searching. See 

Settings | Search Settings | Search Options | Indexing Options: 

  

c. Auto-suggest 

When you type more than one word into the Quick Search bar, SellerDeck will offer search 

suggestions in a drop down box. Click on one and then click ‘Go’ to execute the search. 
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6. Design Improvements 

In previous releases of SellerDeck and Actinic, each theme was limited to the one or two page 

layouts supplied with it. The Design Wizard offered greater flexibility, but operated independently of 

any theme.  

SellerDeck 2013 takes a more holistic approach. The software is supplied with a set of eight different 

page layouts, each of which can be used with any of the eleven built-in themes. Any page layout can 

be used for any page of any site. The Design Wizard further refines the selected theme / layout 

combination, adjusting the page and / or sidebar widths, repositioning key elements such as the 

search bar and cart summary and modifying their styles.  
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7. HTML Emails  

In SellerDeck 2013 Alpha 2, emails from the desktop are sent in MIME format with both HTML and 

plain text content.  The email outer layout can include HTML elements including the company logo. 

This feature is still in development and will be further improved before the production release. The 

beta release supports HTML format for emails sent from the Orders dialog, ie: 

Order Received Email 

Payment Received Email 

Order Shipped Email 

User Definable Emails  

HTML emails can be enabled for each of these email types as follows: 

1. Go to the Library (from the ‘Design’ menu). 

2. Select the ‘Layouts’ tab and scroll down to the ‘Email Outer Layout’ group. Expand it by 

clicking on the [+] icon to its left. 

3. Find the OrderEmailLayout selector and double-click on it. 

4. Untick ‘Hide Selector if Only One Choice Available’ and click ‘OK’. 

 

5. Do the same for the ‘OrderShippedEmailLayout’, ‘PaymentReceivedEmailLayout’ and 

‘OtherEmailLayout’ selectors. 

6. Click ‘Close’ and select ‘Settings’ from the ‘Site Options’ menu. 

7. Click the ‘Layout’ tab and scroll down to the ‘Other’ section. 

8. For each of the following email types, select the ‘Standard Email Layout’. Even if it is the only 

choice available, in the Beta version you must explicitly re-select it. 

Order Email Layout 

Order Shipped Email Layout 

Other Email Layout 

Payment Received Email Layout 

9. Click OK. 

NB in the beta release, HTML code is visible in the Mail editing dialog . 



© 2012 SellerDeck Ltd 

APPENDIX – Web 2.0 features and use of AJAX. 

A fundamental principle of SellerDeck/Actinic Desktop has been to serve up statically generated 

pages. These are fast and well ranked by search engines. Recently, some Web 2.0 techniques have 

been used to extend what has been shown on these static pages after loading the page (including 

display of stock levels) by querying the server from the browser - AJAX calls. 

SellerDeck has always had a set of index files on the server for the search functionality but these 

were rarely used to their full power. The main index relates words, attributes and properties to 

product references. An additional index file relates product references to full information about the 

product. 

With SellerDeck 2013 we have retained the static pages but have used AJAX to make the consumer's 

experience as smooth as possible for the new filtering pages. These calls exploit the indexes, which 

have been extended to include sorting information  (e.g. price ascending, relevance) that can be 

applied in the server or web client. 

On opening a filtering page the browser calls the server and requests a list of all the products that 

match the filtering specification. The list is a compact set of product references including sorting 

information. Details of the products, as required, are loaded in a separate call. These are retained in 

the browser and are used when going through pages of filtering results or calculating counts for 

filter options. This ensures that calls to the server are kept to a minimum.  

A restricted set of functionality for filtering has been implemented purely in the server so that 

consumers with JavaScript disabled in the browser can still use filtering. 

Dynamic Pricing also uses AJAX calls to the server, ensuring that the correct price is displayed in all 

circumstances including when the customer is logged in and may have a special price. 


